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Definitions 
 
Object: Any form, job, menu, or quick flow used in 

Banner 2000. 
 

Class (synonymous with profile): A Banner 2000 class contains role grants to 
specific objects.  They are assigned by profile 
owners to any number of user IDs and any 
number of user IDs may have any number of 
profiles associated with it. 
 

Jobout:  The directory access through FTP or directly 
from Unix that holds the output from Banner 
applications (e.g.: /jobout/username/PRDP). 
 

Profile owner: Profile owners are university administrators 
responsible for categorizing the sensitivity of 
information accessed through objects, and are 
responsible for authorizing access to objects 
for user IDs. 
 

Role: In Banner 2000, this details the level of access 
that a user ID has been granted to a specific 
object. User IDs have no access, query access 
(Q) or modify access (M).  If the user ID has 
query access to an object, then that user ID can 
look up information associated with that 
object; however, any attempt to modify 
information will result in an error.  Modify 
access grants query access in addition to the 
ability to alter data. 
 

User ID: In Banner 2000, this refers to the six-character 
identification issued by Banner Security and 
associated with one specific user. 
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Overview 
 
The Banner Security Matrix Report (GZRMATR) provides access to profile contents, object 
listings, and roles granted by each profile.  It has been developed to allow for easy comparisons 
between profiles and users when determining end user needs.  
 

*** GZRMATR runs only in the PRDP database *** 
 
GZRMATR has three main options: 
 

User ID Report Option:  Use this option to generate a side-by-side comparison of roles 
associated with up to 60 user IDs.  The report will contain: 
 

¾ User IDs  
¾ Full names for each user ID 
¾ Name of authorized profiles  
¾ Roles granted to each user ID for each object1   

 
 

Profile Report Option: Use this option to generate side-by-side comparisons of roles 
associated with up to 60 profiles.  The report contains: 

 
¾ User IDs for each account associated with the profile 
¾ Full names for each user ID 
¾ Name of each profile  
¾ Roles granted to each user ID for each object in each profile  

 
Object Report Option: Use this option to generate lists of all profiles containing any of up 
to 60 objects and all user IDs authorized access to each profile.  The report contains: 

 
¾ User IDs for each account associated with the profile 
¾ Full names for each user ID 
¾ Name of each profile  

 
 
 

**Reports will compare only values of the same option (User IDs/Profiles/Objects)** 
 

                                                 
1 Note:  Only the highest level of access is returned; if a user ID has both query and modify roles granted for one 
object, only the modify role will be displayed. 
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Understanding the Form 
1) Log on to Banner Prod Prime (PRDP). 

2) Enter GZRMATR in the Direct Access field and press ENTER. 

3) Click in the input box below the word Printer in the block labeled A.  You will be presented 

with this screen: 

 

 
 
Block A – Printer Control 

This block controls where the output will be printed.  A copy of the output files will be 
located in your jobout directory; use this option to also print the file (many files are very 
long, so this is not recommended).  NOPRINT will be inserted into this line by default. 

 
Block B –  Parameter Values 

This block controls what option of the report (user ID, profile or object) you will run as 
well as the specific values you will run the report against.  Please remember that you can 
only run reports against options of the same kind (e.g., profiles vs. profiles) 

 
Block C – Submission 

When you have finished entering the parameters for your job, you must click in this block 
before submitting the job.  If you wish to save the parameters you entered in block B, 
click Save Parameters; otherwise, leave this block blank.  
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Running the User ID Report 
 

 
 

1) Log on to Banner Prod Prime (PRDP). 
2) Enter GZRMATR in the Direct Access field. 
3) Click under the word Printer in block A. 
4) In the third column of the first row of block B (Object Access Type), enter one of the 

following values: 
a) To return only accounts having Query access, do not erase the Q. 
b) To return only accounts having Modify access, replace the Q with an M. 
c) To return all accounts having either Query or Modify access, delete the Q and leave this 

field empty (recommended). 
5) In the second row, leave 02 in the first column; the second column will default to User ID.  

Enter one user ID in the third column.   
6) Starting in the third row, replace the value in the first column with 02; the second column 

will default to User ID.  Enter one user ID in the third column.   
7) Repeat step six using additional rows as necessary. Remember to replace or enter the value 

02 in the first column of each row.  After you enter a value in the last row appearing on the 
screen, another blank row will become available below the line that you can access by 
pressing the down arrow, allowing additional input. 

8) When you have entered all the user IDs you wish to look up, click in block C to set your 
search. 

9) On the File menu, click Save.  You can only save after you have clicked in block C. 
10) The output will be directed to your jobout directory. 
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Reading the Output From the User ID Report 
 

When you enter one or more user IDs for comparison, the program will return files into your 
jobout directory.   For example, the report on prdsss and tstxxx returned the following 
results: 
 

The file with the extension .lis contains the following information (reformatted for this handout): 

T

 

 
 
 
 

No User ID User Name Count of Profiles Count of Objects

1 PRDSSS Franklin, Robert, J. 6 3,322
2 TSTXXX Johnson, Andrew, B. 7 2,037
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The column No displays the order in which the names were entered. 
The column User ID displays the user ID entered in uppercase. 
The column User Name displays the full name associated with the user ID. This is ordered 

alphabetically by the last name of each user ID.  
The column Count of Profiles displays the number of profiles associated with each user ID. 
The column Count of Objects displays the number of objects associated with each user ID. 
 
he file with the extension .lis2 contains the following information (reformatted for this handout): 
 
 
 
 
 
 
 
 
 
 
 

The column Process displays all of the profiles associated with any user ID entered. 
The column Object displays a 1 when the user ID has access to that profile and a - when it does 

not.  The order of user IDs from left to right mirrors the order in which they were submitted, 
as displayed in the .lis output file. 

The column Type displays the name of each object. 
The column Name displays a description of each object. 
The column Description displays in the first column the kind of object (F= form, J= job, etc.) 

and in the second column, the highest role each user ID has associated with each object. The 
order of user IDs from left to right mirrors the order displayed in the .lis output file, 
alphabetically by last name. 

Process Object

*BANA 11
*HRSEC01 -1
*PRD01S 1-
*PUBLIC 11
*SEC002 11

Type Name Description

AAAACKN Dues Acknowledgement Form F M-
AAAACKR Dues Acknowledgement Rules Form F Q-
AAAADJS Dues Adjustment Form F -Q

          AAACMEM Co-Member Form F -M 
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 Running the Profile Report 
 

 
 
1) Log on to Banner Prod Prime (PRDP). 
2) Enter GZRMATR in the Direct Access field. 
3) Click under the word Printer in block A. 
4) In the third column of the first row of block B (Object Access Type) enter one of the 

following values: 
a) To return only accounts having Query access, do not erase the Q. 
b) To return only accounts having Modify access, replace the Q with an M. 
c) To return all accounts having either Query or Modify access, delete the Q and leave this 

field empty. 
5) Starting from the second row, enter 03 in the first column; the second column will default to 

Profile Name.  Enter one profile name in the third column. ALL PROFILES MUST 
START WITH *. 

6) Repeat step five using additional rows as necessary.  Remember to replace or enter the value 
03 in the first column of each row. After you enter a value in the last row appearing on the 
screen, another blank row will become available below the line that you can access by 
pressing the down arrow, allowing additional input. 

7) When you have entered all the profiles you wish to look up, click in block C to set your 
search. 

8) On the File menu, click Save.  You can only save after you have clicked in block C. 
9) The output will be directed to your jobout directory. 
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Reading the Output from the Profile Report 
 

When you enter one or more profiles for analysis, the program will return files into your jobout 
directory.   By way of example, the report on *HONXXX and *HONXYZ returned the following 
results: 
 

The file with the extension .lis contains the following information (reformatted for this handout): 
 

The column No displays the order in which the profiles were entered. 
The column Profile displays the name of each profile in uppercase in alphabetical order. 
The column Count of Users displays the number of user IDs associated with each profile. 
The column User ID displays each user ID associated with each profile in uppercase. 
The column User Name displays the full name associated with the user ID. 
The column Count of objects displays the total number of objects associated with each profile. 
 

The file with the extension .lis2 contains the following information (reformatted for this handout): 
 

 
The co

pr
The co
The co

ea

No Profile Count of Users User ID User Name Count of Objects

1 *HONXXX 2 18
UHPXXX Peterson, Christopher, W.
UHPXYZ Kelly, Audrey, M.

2 *HONXYZ 1 2
ESIXXX DiNatale, Elizabeth, R. 

         
Process Object Type
Name Description

*HONXXX
*HONXYZ

GOAEMAL E-mail Address Form F Q-
SFAREGQ Registration Query Form F M-
SFAREGW GW Student Course Registration Form F MM 
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lumn Process Name displays all the profiles queries and all objects associated with any 
ofile. 
lumn Object Description displays the full name associated with each object name. 
lumn Type displays the kind of object (F= form, J= Job, etc.) and the role associated with 
ch object in question (listed left to right in alphabetical order).  
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Running the Object Report  
 

 
 
1) Log on to Banner Prod Prime (PRDP). 
2) Enter GZRMATR in the Direct Access field. 
3) Click the mouse under the word Printer in block A. 
4) In the third column of the first row of block B (Object Access Type), enter one of the 

following values: 
a) To return only accounts having Query access, do not erase the Q. 
b) To return only accounts having Modify access, replace the Q with a M. 
c) To return all accounts having either Query or Modify access, delete the Q and leave this 

field empty. 
5) Starting from the second row, enter 04 in the first column, the second column will default to 

Object Name and enter one Object Name in the third column.   
6) Repeat step five using additional rows as necessary.  Remember to replace or enter the value 

04 in the first column of each row. After you enter a value in the last row appearing on the 
screen, another blank row will become available below the line that you can access by 
pressing the down arrow, allowing additional input. 

7) When you have entered all the objects you wish to look up, click in block C to set your 
search. 

8) On the File menu, click Save.  You can only save after you have clicked in block C. 
9) The output will be directed to your jobout directory. 
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Reading the Output from the Object Report 
 

When you enter one or more objects for analysis, the program will return files into your jobout 
directory.   By way of example, the report on GUPOXREF and GZRMATR returned the 
following results: 
 

The file with the extension .lis contains the following information (reformatted for this handout): 
 

 
The column No displays the order in which the names were entered. 
The column Object Name displays the direct access code associated with each object name 

displayed in alphabetical order. 
The column Object Description displays the full name associated with each object name. 
The column Count of Users displays the number of users associated with each object. 
 

The file with the extension .lis2 contains the following information (reformatted for this handout) 
 

The column Profile displays all of the profiles associated with any objects submitted. 
The column Name displays each user ID associated with the profile. 
The column Type displays the kind of object (F= form, J= job etc). 

* The column on the right contains in the first row the role associated with each object in 
question (listed from left to right in alphabetical order).   Below this, the full name associated 
with each user ID is listed. 

 
 

No Object Name Object Description Count of Users

1 GUPOXREF BANNER Security Report 224
2 GZRMATR Banner Security Matrix Report 69 

Profile Name Type

*SEC002 J M-
ADMXXX King, Samantha
ADMXYZ Schroeder, Matthias
SISXXX Mahoney, Patrick

                    SISXYZ Anderson, Katrina, D. 
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Notes 
 
1) GZRMATR will only run on the PRDP database. 
 
2) To format your output for easy reading, complete the following steps: 
 

a) FTP the file to your desktop computer (FTP instructions are available from the Banner 
website). 

 
b) Open a new document in Microsoft Word. 
 
c) Under the File menu, select Page Setup. 
 
d) In the Page Setup window, click Margins. 
 
e) Set the Top, Bottom, Left, and Right margins to .5. 
 
f) In the Page Setup window click the tab marked Paper Size. 
 
g) Select Landscape orientation. 
 
h) Click OK. 
 
i) Under the Insert menu, select File. 
 
j) Highlight the .lis file that you FTP’d (you will have to change the Files of Type option to 

All) and click OK. 
 
2) Using global Variables: 
 

GZRMATR is designed to allow the use of one global variable, denoted by %, for each 
report.  For example, entering prd% when running a user ID report will return 
information for all user IDs that begin with prd.  However, running a user ID search by 
entering prd% and then entering any other user ID (as you would when running standard 
user ID report) will result in an error because reports using global variables can 
contain only one parameter!  

 
 The same restriction exists in all GZRMATR reports. 

 
3) Limit on the number of concurrent searches: 
 

While GZRMATR was designed to allow reports with many values, there is a limit to the 
size of the output that will be created.  Generally, searches should not exceed 60 inputs in 
any one report (e.g., 60 different user IDs). 
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